Continuacdo do tutorial Adobe Flex Builder a partir do zero
http://msdevstudio.com/blog/2008/03/01/adobe-flex—a-partir-do-
zero-parte—-iii

6 - Componentes e Médulos

6.1-As diferencas entre componentes e médulos.

Inicialmente as diferencas podem ndo parecer muitas, mas na realidade faz toda a
diferenca, no menu do flex builder se clicarem em File -> New conseguem ver uma
lista, de entre os quais existem “MXML Module” e também “MXML Component”. A
grande diferenca destes 2 é que o Componente ao ser criado estard disponivel
para “juntar” ao nosso “stage” principal como elemento drag & drop na janela
“Components” na pasta “Custom”, e o Mdbdulo ndo estard acessivel dessa forma.

Algumas caracteristicas dos Componentes:

-Podem ser baseados em componentes ja& existentes (Painel, Canvas, TitleWindow,

)
-380 controlados facilmente através do nosso “stage” Jj& que passam a estar
incorporados no nosso .swf principal
—-Aumentam o tamanho do nosso swf final e por consequente afectam o desempenho da
nossa aplicacéo.
-Em aplicacdes maiores podem causar alguma confusdo no cdédigo.

Quanto aos componentes, estes sdo “Aplicativos” independentes ou seja, séo
criados como se pertencerem a nossa aplicacdo principal, mas na realidade estéo
fora dela prépria. Cada médulo cria um .swf préprio, que é completamente externo
a nossa aplicacdo, além de poder ser usado em futura aplicacdes deixa o nosso
cdbdigo bem mais simples, e muito mais facilmente editdvel e organizado.

Algumas caracteristicas dos Mdbédulos:

-Leves, rapidos e compactos.

-N&do aumentam o tamanho da nossa aplicag¢do principal.

-Podem ser facilmente alterados sem ter que alterar a aplicacdo principal.
-Facilmente actualizdveis junto da nossa aplicacdo principal.

-Podem ser re-usados em qualquer outra aplicacéo.

Um dos grandes problemas para quem ndo tenha grande conhecimento de action
script pode ser a comunicacdo da nossa aplicacédo principal com o nosso mdédulo,
ja& que grande parte da nossa comunicacgdo deverd ser feita através de eventos.
Mas mais a frente mostrarei um exemplo de como chamar uma funcdo do nosso médulo
e tratar a resposta dessa funcdo na nossa aplicacdo principal.
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6.2-Criando um Componente e trabalhando com ele

Um componente como disse em cima ndo é nada mais que um componente
personalizado, como se se trata-se de por exemplo um painel personalizado logo é
tratado como componente na nossa aplicacédo.

Vamos entdo criar um Componente, tomando em conta que ainda continuamos a usar a
nossa aplicacdo olaMundo que criamos anteriormente, e para isso vamos ao menu do
flex builder e escolhemos:

File => New -> MXML Component

Como “filename” escrevemos dbConf e na opcédo “based on” procuramos na lista o
TitleWindow e deixamos o resto como estd clicando no “finish”.

Se tudo correu bem, ter-vos-a aparecido um novo documento (dbConf.mxml) apenas
com o cdédigo:

<?xml version="1.0" encoding="utf-8"?>
<mx:TitleWindow xmlns:mx="http://www.adobe.com/2006/mxml" layout="absolute"
width="400" height="300">

</mx:TitleWindow>

A diferenca entre este cbédigo e o cbddigo que aparece ao criar-mos a nossa
primeira aplicacdo é que este inicia logo com o <mx:TitleWindow> para indicar ao
compilador que a sua base serd a TitleWindow deverd ser tratado como tal na
nossa aplicacdo principal.

Se clicarem no modo de “design” verdo que apenas é apresentado o nosso
TitleWindow. Vamos aproveitar ja para fazer deste componente 0 nosSso menu para
fazer um sistema de login com uma futura ligacdo a uma base de dados mysqgl,
colocando 3 labels, 2 inputText (um deles como password) e 2 botdes.

Fica ao vosso critério a colocacdo dos labels “titulo”, “username :”, “password
:” e dos campos inputText com os id's respectivamente iguais a “inputUser” e
“inputPass”. E o nosso bot&do com o id “btnLogin”.

Notem que nas opg¢des do inputText “password” devem seleccionar nas propriedades
o “Display as password” colocando-o a “true”.

Usando a minha interface e cdédigo:

<?xml version="1.0" encoding="utf-8"?>
<mx:TitleWindow xmlns:mx="http://www.adobe.com/2006/mxml" layout="absolute"
width="400" height="300">

<mx:Label x="80.5" y="58" text="CONFIGURACAO DA BASE DE DADOS"
width="219"/>

<mx:Label x="75" y="103" text="Username:" width="75"/>

<mx:Label x="75" y="129" text="Password:" width="80.5"/>

<mx:TextInput x="158" y="101" id="inputUser"/>

<mx:TextInput x="158" y="127" displayAsPassword="true" id="inputPass"/>

<mx:Button x="158" y="157" label="Login" width="160" id="btnLogin"/>

</mx:TitleWindow>



Estara algo como:

CONFIGURACAC DA BASE DE DADOS

Username:

Password:

l Login J

Guardamos este componente e voltamos ao nosso exemplo old mundo.

Como a nossa aplicacdo olad mundo j& estd a ficar um tudo nada “non-friendly” ou
seja, j& estd a ficar com muitas “inutilidades” vamos comecar por eliminar
alguns componentes que cridmos...

como tinhamos um painel a ser adicionado por action script logo no inicio, vamos
limpar um pouco a nossa aplicacdo; Um dos pontos que ndo tinha falado
anteriormente era como remover O nosso painel criado por via de action script do
nosso “stage”, mas facilmente conseguiriam tira-lo ao criar um botdo que
executasse o seguinte cdédigo : this.removeChild(“id”); onde o id seria o nosso
id criado pela funcdo, neste caso this.removeChild(“panel3”); (“novo”) ou entdo
de uma maneira mais drastica:

this.removeAllChildren(); que elimina todos os nosso componentes adicionados com
o addChild.

Vamos entdo desactivar o creationComplete na aplicacdo onde carregava 0OS Nosso
outros componentes, (painel o0lad mundo, botdo “old” e “Adiciona panel” ), para
isso basta retirar do <mx:Application ... > o “trigger”
creationComplete="criaTudo()”.

Ficamos apenas com a nossa dataGrid e os nosso efeitos. Vamos aproveitar para
adicionar uma ApplicationControllBar que pode ser arrastada para o nosso stage,
coloquem-na no topo do stage e adicionem-lhe um bot&do com o label “Ligar BD” de
maneira a que no vosso cédigo fique algo como:
<mx:ApplicationControlBar x="10" y="6" width="589">

<mx:Button label="Ligar BD"/>
</mx:ApplicationControlBar>

vamos entdo ao nosso mainScript.as e fazemos as seguintes actualizagdes:

no topo a seguir aos nosso imports vamos colocar:
import dbConf;
import mx.managers.PopUpManager;

e no final a seguir a nossa ultima funcdo a funcdo seguinte:



private function abrePainellogin(centrado:Boolean) :void {
var painel:dbConf = new dbConf () ;
painel.showCloseButton=true;
PopUpManager.addPopUp (painel, this, true);
if (centrado==true) PopUpManager.centerPopUp (painel) ;

e no nosso dbConf.mxml colocamos na nossa tag <mx:TitleWindow ...> o seguinte:
close="PopUpManager.removePopUp (this)" removedEffect="fechar"

(notem que adicionei um pequeno efeito para fechar (removedEffect) que vamos
criar a seguir com o id “fechar”)

e teremos que fazer o import do PopUpManager sendo vamos ter erros... basta
adicionar antes do </mx:TitleWindow> o seguinte:

<mx:Script>
<! [CDATA[
import mx.managers.PopUpManager;
11>
</mx:Script>

de volta ao nosso olaMundo.as no botdo que criamos dentro da nossa control bar
no “trigger” click chamamos a nossa fungdo (centrada=true):

<mx:ApplicationControlBar x="10" y="6" width="589">
<mx:Button label="Ligar BD" click="abrePainellLogin (true)"/>
</mx:ApplicationControlBar>

e vamos criar os nosso efeitos chamados ao fechar o panel, para isso colocando o
efeito a seguir a nossa applicationControlBar:

<mx:Parallel id="fechar">
<mx:Zoom />
<mx:Fade />
</mx:Parallel>

Vamos entdo a explicacgdes. O que fiz foi importar o nosso dConf.mxml para o
nosso stage para ser usado, e importei também o PopUpManager que serd usado para
fazer do nosso dbConf um popUp.

Criei a funcd@o para abrir o nosso dbConf como popup e adicionei um parémetro que
é recebido na funcdo: centrado:Boolean que receberd apenas (true ou false) que
serve para vos explicar também como enviar pardmetros para a fungdo ao ser
chamada. Dentro dessa funcdo declarei a variavel painel como “portador” do nosso
dbConf.mxml e adicionei-lhe um bot&o de fechar:

painel.showCloseButton=true;

no nosso dbConf.mxml adicionamos o trigger “close” para remover O popup ao
fechar no nosso dbConf.mxml e o removedEffect para executar o efeito que criamos
ao ser fechado.

O nosso efeito com id="fechar” é um efeito paralelo, ou seja ambos os efeitos
Zoom e Fade sdo executados ao mesmo tempo.

Podem guardar os vosso ficheiros CTRL+SHIFT+S, e corram a aplicacdo... se
carregarem no Login BD aparecerd o nosso dbConf.mxml e se clicarmos no boté&do de
fechar o nosso painel serd removido com o efeito zoom+fade (“fechar”).

Em si trabalhar com componentes é assim tdo simples como importa-los e usa-los.



6.3 Enviando e recebendo dados de/para o nosso componente.

Para comunicarmos com O nosso componente, no caso de queremos enviar dados para
ele, torna-se tdo simples com o seguinte (suponhamos que no campo user do nosso
dbConfig queremos colocar um user predefinido), basta na funcéo
“abrePainellogin” colocarmos O seguinte:

painel.inputUser.text="teste";

a seguir ao PopUpManager.createPopUp() ;

se escreverem painel. Aparece toda a lista de elementos do nosso painel,
incluindo labels, buttons e inputs.

Para recebermos dados do nosso painel existem duas formas, ou adicionamos um
eventListner para detectarmos a instrucédo de fechar, e acedermos as propriedades
antes de remover O popup:

painel.addEventListener (CloseEvent.CLOSE, buscaDados) ;
private function buscaDados (event:CloseEvent) :void{
Alert.show(event.currentTarget.inputUser.text);

}

Este tipo de funcdo e evento, ndo é muito usual e acaba por obrigar a duplicacéo
de cédigo...e apenas é disparado gquando o popup é fechado, e por isso ndo é
muito aconselhdvel em projectos grandes que necessitamos de usar o mesmo
componente varias vezes em diferentes objectivos e de saber determinados valores
sem estarmos dependentes dos events do componente.

A segunda forma é a mais ldégica, que é disparar eventos personalizados e usar o
eventListner para os escutar. Vamos por exemplo alertar o user que clicou no
botdo “Login” do nosso popup dbConfig.

O mais rédpido seria colocar um evento no click do botdo, mas vamos verificar
isso com o nosso stage para termos a certeza que o nosso dbConf estd a enviar
dados/eventos para o nosso Stage.

Para isso basta criarmos uma fungdo no nosso dbConf a seguir ao
import mx.managers.PopUpManager;

private function clickado () :void {
this.dispatchEvent (new Event ("clickado"));

}
e vamos chamar esta funcdo no botdo login no “trigger” click:

<mx:Button x="158" y="157" label="Login" width="160" id="btnLogin"
click="clickado ()" />

se salvarem e correrem a vossa aplicacdo agora e chamarem o popup Jj& aparece o
campo user com o texto “teste” e se carregarem no login, nao acontece nada, mas
na realidade ao ser clickado estd a despachar o evento “clickado”, mas nada
acontece porque ndo o estamos a escutar em lado nenhum. Vamos entdo ao nosso
mainsScript.as e na funcédo “abrePainellLogin” antes do popUpManager.createPopup
colocamos:

painel.addEventListener ("clickado", lidaClickado);

e no mesmo mainScript.as criamos a seguinte funcéo:



private function lidaClickado (event:Event) :void{

Alert.show ("O botdo Login do painel dbConf foi clickado!!\nO texto escrito
nos campos\n user: "+event.currentTarget.inputUser.text+"\npass:
"+event.currentTarget.inputPass.text+"\n\nCerto ??");

}

salvem os vossos ficheiros e corram a aplicacdo. Testem o botdo Login com
diferentes valores nos inputs user e pass.

Como podem ver podemos criar eventos onde gquisermos e sempre que quisermos, esta
forma do dispatch event, é muito UGtil porque podemos usar O nosso componente
onde quisermos e sem ter que o estar a alterar para adaptar a uma outra
aplicacéo.

6.3 - Criando um Mdbdulo e trabalhando com ele

A nivel de médulos o sistema funciona quase da mesma forma gque um componente
como foi ditem em cima, excepto que no caso de mbdédulos a comunicacdo entre o
médulo e a nossa aplicagédo é mais elaborada.

Vamos criar um méddulo com o mesmo componente que criamos antes (dbConf.mxml) :
File->New->MXML Module

vamos dar-lhe o nome de modLogin e deixar os tamanhos como (250*%200) e ao fundo
vemos a opg¢do de optimizacdo, neste caso vamos escolher “Do not optimite...”
para gque possamos depols testar em outra aplicacgdo gque n&o o nosso olaMundo.
Abre-se entdo o nosso recem-criado médulo:

<?xml version="1.0" encoding="utf-8"?>

<mx:Module xmlns:mx="http://www.adobe.com/2006/mxml" layout="absolute"
width="250" height="200">

</mx :Module>

que funciona exactamente igual ao nosso dbConf ou olaMundo, com modo design
activo também. Vamos entdo copiar o contudo do cdédigo do dbConf.mxml
(exceptuando o <mx:TitleWindow> e </mx:TitleWindow>) e colar dentro do nosso
modLogin:

<?xml version="1.0" encoding="utf-8"?>
<mx:Module xmlns:mx="http://www.adobe.com/2006/mxml" layout="absolute"
width="250" height="200">

<mx:Label x="15.5" y="10" text="CONFIGURACAO DA BASE DE DADOS"
width="219"/>

<mx:Label x="10" y="54" text="Username:" width="75"/>

<mx:Label x="10" y="93" text="Password:" width="80.5"/>

<mx:TextInput x="80" y="52" id="inputUser"/>

<mx:TextInput x="80" y="91" displayAsPassword="true" id="inputPass"/>

<mx:Button x="80" y="139" label="Login" width="160" id="btnLogin"
click="clickado ()" />

<mx:Script>

<! [CDATA [
//import mx.managers.PopUpManager;

private function clickado () :void {
this.dispatchEvent (new Event ("clickado"));

11>
</mx:Script>
</mx:Module>



e vamos apagar/comentar a linha import mx.managers.PopUpManager; ja que nao
necessitamos dela para nada neste caso. (Notem que eu alterei um pouco posicdes
relativas (x,y) do nosso mx:Module para caber no nosso stage.)

Guardamos e o nosso mdédulo estd criado, bem simples, vamos agora de volta ao
nosso olaMundo e vamos inserir no cdédigo um painel, um ModuleLoader e uma
ProgressBar (ambos drag & drop) mas por questdes de ficar com o layout igual ao
meu basta colarem o seguinte no cdédigo do olaMundo antes da tag
</mx:Application>:

<mx:Panel x="10" y="47" width="354" height="310" layout="absolute">
<mx:ModuleLoader x="10" y="10" width="314" height="226" id="loader">
</mx:ModuleLoader>
<mx:ProgressBar x="124" y="240" id="loaderBar"/>
</mx:Panel>

defini também o id da progressBar como “loaderBar” e do nosso ModuleLoader como
“loader”

vamos adicionar o seguinte botdo a nossa applicationBar a seguir ao nosso botédo
Ligar BD:
<mx:Button label="Carrega Modulo" click="carregaModulo ()"/>

e no nosso mainScript.as a seguinte funcéo:
private function carregaModulo () :void({

loader.url="modLogin.swf";
loader.loadModule () ;
loaderBar.source=loader;

aqui indicamos que o modulo a carregar no loader é o modLogin.swf (depois de a
aplicacdo compilada no nosso modLogin é compilado num swf a parte com o nome de
modLogin.swf) e que a progressBar “loaderBar” deve ter como source O nosso
moduleloader “loader” para acompanhar o seu carregamento.

Salvem e corram, cliquem no Carrega Modulo e verdo o vosso modulo a ser
carregado bem como o progresso do carregamento na ProgressBar, como no final do
médulo e antes desse carregamento a progressBar deixa de ter sentido, vamos
oculta-la antes e depois do carregamento, mostrando-a apenas durante o
carregamento do médulo. Para isso vamos colocar na tag <mx:ProgressBar ..> o
seguinte: visible="false"

e na nossa funcdo carregaModulo:

loaderBar.visible=true;

e para a ocultarmos, deveremos ainda colocar um eventListner para sabermos
quando o médulo ja foi carregado para que entdo possamos ocultar a nossa
progressBar:

loader.addEventListener (ModuleEvent .READY, loadTerminado);

e criar a funcédo para ocultar:

private function loadTerminado (event:ModuleEvent) :void{

loaderBar.visible=false;
loader.removeEventListener (ModuleEvent .READY, loadTerminado);



salvem e corram o vosso aplicativo, agora apenas é apresentada a barra da
progressBar enquanto o mbédulo estd a ser carregado.

Quanto a acedermos e enviarmos dados para o nosso médulo, as coisas ficam um
pouco mais complexas do que um componente.

Para receber dados ou obter dados, podemos usar o event dispatcher que criamos
com o event “clickado”, que vamos Jj& passa a testar.

Na funcédo loadTerminado vamos adicionar o seguinte:
loader.child.addEventListener ("clickado", lidaClickado) ;

e aproveitamos a mesma funcdo lidaClickado criada anteriormente, se correrem a
aplicacdo verdo que funciona na mesma.

Para enviarmos dados ou definir dados no médulo, temos duas formas, se os dados
a receber form cruciais a aplicacdo, ou seja, forem sempre necessarios,o que é
aconselhado por uma questdo de reutilizacdo de cédigo, é criarmos uma funcdo no
médulo que recebe o pardmetro/texto a definir. Se por outro lado a informacdo a
receber no médulo for apenas esporadica, podemos aceder directamente ao
componente, ou elemento que queremos afectar..

Vou passar a explicar as duas formas, tomando por exemplo que queremos colocar
dados no campo inputUser do nosso modulo apds o seu carregamento.

Vamos criar uma funcgdo no nosso modLogin, a seguir & funcdo que despacha o nosso
evento clickado, da seguinte maneira:

private function defineUser (user:String) :void{

inputUser.text=user;

voltamos entdo ao nosso mainScript.as a seguir a funcédo loadTerminado e criamos
a seguinte funcéao:

private function define() :void({

if ((loader.getChildren()) .length>0) (loader.child as
modLogin) .defineUser ("TESTANDO") ;

else Alert.show("Modulo ainda Ndo carregado");

esta funcéo verifica se o nosso loader (ModulelLoader) jé& possui algum “child”,
ou seja, se o nosso modLogin j& estd disponivel para ser utilizado, e caso
esteja chama a nossa funcdo defineUser do médulo.

Notem que ao colocar loader.child as modLogin estamos a indicar que o
child/modulo carregado é uma “copia” do nosso modLogin para que o child do
loader seja disponibilizado/utilizado com as fungdes e componentes do modLogin.

Para aceder ou definir qualquer dado do nosso module, este deve ser sempre
tratado como disse em cima.

Esta é uma forma de passar pardmetros através de uma funcgdo, vamos entdo ve-la
em acgdo, para isso vamos criar um bot&o no nosso olaMundo.mxml ao fundo do
nosso painel, ao lado da progressBar “invisivel” e em baixo do nosso
moduleLoader.



Mais uma vez por questdo de layout serd melhor copiarem o cdédigo:
<mx:Button x="10" y="244" label="Define user" click="define();"/>
e colocarem-no em baixo a seguir ao:

<mx:ProgressBar visible="false" x="124" y="240" id="loaderBar"/>

Salvem a vossa aplicacédo e testem, se clicarem no botdo “Define user” sem o
modulo estar carregado v&o receber um erro “Modulo ainda ndo carregado”, mas se
carregarem o médulo e voltarem a clicar nesse mesmo botdo, o textInput do user
passard a ser definido como “TESTANDO”.

A outra possibilidade sem vez de utilizar uma funcdo do médulo serd aceder
directamente ao campo inputUser e definir o seu texto, bastando substituir na
funcdo que criamos o chamar da funcdo pelo campo, definindo ai o seu valor
(.text). Ficaria algo como:

private function define () :void{

if ((loader.getChildren()) .length>0) (loader.child as
modLogin) .inputUser. text="TESTANDO"

else Alert.show("Modulo ainda N&o carregado") ;

}

e teriam o mesmo efeito, mas a aceder directamente ao campo. Se necessitarem de
usar bastantes vezes dados/funcdes do modulo, é altamente aconselhdvel definirem
uma variavel global para guardar o vosso modulo, para evitar estarem sempre a
escrever (loader.child as modLogin), algo como definir no nosso mainScript.as, a
seguir aos imports o seguinte:

public var modulo:*;
e na funcdo loadTerminado colocarem:
modulo=(loader.child as modLogin) ;

e aproveitamos para testar, substituindo na funcédo define o
(loader.child as modLogin) por modulo e ficariamos com algo como:

private function define () :void{
if ((loader.getChildren()) .length>0) modulo.inputUser.text="TESTANDO"
else Alert.show("Modulo ainda N&o carregado") ;

desta feita, podemos aceder ao nosso modLogin em toda a aplicacdo (olaMundo)
através da variavel modulo.

O trabalho com mbédulo pode passar por ser mais dificil, mas na hora da
publicacdo da vossa aplicacdo e principalmente na hora da reutilizacédo dos
mesmos componentes por outras aplicagdes, torna-se muito mais simples e util, jé
gue nos pouca dezenas, se ndo, centenas de linhas de cbédigo além de que o nosso
médulo pode ser distribuido e utilizado por outros utilizadores em outras
aplicacgdes de uma maneira simples e répida.



7. Entendendo a comunicagdo com Objectos Remotos (php/mysql) via amfphp

O flex em si ainda ndo estd completamente implementado com outras linguagens de
programacdo, e embora j& se possa criar uma aplicac&o com acesso a uma base de
dados (Data->Create Application from database) o seu potencial é um bocado
limitado comparando com as possibilidade de uma linguagem como o php, & como por
vezes precisamos de dados de uma linguagem “server-side” ai o flex ndo tem mesmo
qualquer potencialidade...

Por este e por muitos outros factores, existem varios “aplicativos” que servem
de interface para que o flex possa comunicar com praticamente qualquer linguagem
server side, tais como:

— PYamf, para Python
— AmfPHP para PHP
— FabreAMF para PHPS
— BlazeDS para Java
— Red5 para Java
— Fluorine para .Net

Basicamente o que estes sistemas fazem é transformar os pedidos do Action Script
e transformarem-nos em pedidos para a linguagem destino, e devolver os
resultados desse pedido a linguagem para um formato que o Action Script possa
entender através de um processo chamado serializacgéo.

Cada um dos sistema em cima necessita de algumas configuracdes que podem
encontrar junto do download ou na pagina desses mesmos sistemas.

O que vou falar chama-se amfPhp. Devem entdo fazer o download do mesmo em

e podem também encontrar no site ofical (http://www.amfphp.org/) alguma
documentacdo bem como alguns exemplos e tutoriais.

Depois do download feito, basta extrairem o contetdo do arquivo (.zip) para
qualquer directoria e estd pronto a usar. E bem simples o seu funcionamento como
vamos ver mais a frente. Agora vamos proceder as configurag¢des necessarias para
poder ter a correr no nosso olaMundo um sistema que nos permita trabalhar com o
php e por consequente o mysqgl.

Vamos copiar entdo a pasta “amfphp” para dentro da pasta do nosso projecto e de
seguida abrir essa mesma pasta, se seguida abrir a pasta “services” onde podem
encontrar um ficheiro que diz “place services here”, ora estamos no sitio certo
para criar o nosso servicgo.

Um servigco é como se tratasse de uma interface dentro do préprio amfphp, é
também o servico que serd identificado no flex.

Notem que para isto funcionar necessitam de ter o vosso projecto (olaMundo)
dentro de um “servidor” web que tenha suporte a php. Existem alguns bastante
simples de instalar e de colocar a funcionar, tal como o WAMP

dngxﬁwnvwnvmnpsmwenconﬂ), bastando depois instalar com os pardmetros por
defeito e escolher o user e password da base de dados do mysgl (vamos usa-los de
seguida)

Este processo de trocar o nosso projecto (olaMundo) para uma directoria
diferente da actual é mais complicado do que apenas mudar a localizacdo, ja& que
o flex ndo gosta muito disso e ainda por cima devemos trocar o0 nosso projecto
para trabalhar com um servidor. O que aconselho, supondo que instalamos o wamp

em CJ“&HHQ é fazer o seguinte. Salvamos todos os nossos ficheiros do projecto
(olaMundo) e fechamos o projecto (botdo direito->Close Project).


http://www.amfphp.org/
file:///C:/wamp
file:///C:/wamp
file:///C:/wamp
http://www.wampserver.com/
http://www.wampserver.com/
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Vamos depois copiar a pasta do nosso projecto para o servidor em c:\wamp\www\

Voltamos ao flex e no final do projecto fechado temos que o apagar (botéo
direito->Delete) e escolher “Do not delete Contents” Jja& que o novo projecto a
importar terd o mesmo nome.

No final vamos ao menu File->New->Flex Project.

No nome colocamos olaMundo, em projecto location, clicamos na “checkbox” para
alterar e colocamos c:\wamp\www\olaMundo e em baixo escolhemos Application
Server Type -> PHP

Clicamos em Next e deveremos colocar (se ndo foi colocado automaticamente)
Web root: c:\wamp\www\olaMundo

Root Url: http://localhost/olaMundo

Output Folder: bin-debug
clicamos em Validate Configuration e de novo em Next

em Main source folder: (aqui devemos verificar se na pasta olaMundo do nosso
c:\wamp\www\olaMundo o olaMundo.mxml estd na raiz da pasta ou na pasta src, Ja
que na altura da criacdo do nosso pojecto anterior eu defini o main source
folder sem valor e logo foi criado o olaMundo.mxml na raiz, se usaram os valores
por defeito na altura da criacao devem deixar estar como “src” )

Vamos supor que estd na raiz, e limpamos este campo, em Main Application File
devemos ter o olaMundo.mxml, clicamos em finish e o flex actualizard o nosso
projecto e estéd pronto para usar de novo, mas desta feito no nosso servidor.

Voltando a pasta c:\wamp\www\olaMundo\amfphp\services\

Vamos criar uma pasta chamada ola e dentro dela criar um ficheiro de texto com o
nome de mundo e guarda-lo com a extensédo php, se o ficheiro ndo for guardado
como .php deve aparecer o nome como mundo.php e ao abrir vi abrir no bloco de
notas (é sinal que o Sistema Operativo estd a ocultar extensdes), neste caso,
apaguem o ficheiro (mundo.php.txt) e voltem a pasta services, abram a pasta
amfphp e copiem o ficheiro que ela contem (DiscoveryService.php) e copiem-no
para a pasta ola, depois mudem o nome para mundo e abram esse ficheiro no bloco
de notas e apaguem todo o seu conteudo e escrevam apenas O seguinte a titulo de
exemplo:

<?php

class mundo

{
function teste (Snome) {

return "0l4 ".Snome;

function mundo () {

//Funcdo principal do servico, que poderd guardar varidveis
//sempre disponiveis ao longo das nossas fungdes, tal como
//uma ligacdo a base de dados

}
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?>
e guardem o ficheiro.

O amfphp tem um browser que permite escutar os nossos servicos e testa-los, logo
vamos aproveitar para testar o servico que criamos. Acedam com O VOSSO browser
de internet a: http://localhost/olaMundo/amfphp/broswer e vai-se abrir uma
pagina a pedir informacgdes sobre o gateway, que devem deixar estar como estd por
defeito clicando em save.

Do vosso lado esquerdo deve aparecer o0s servicos amfphp e o nosso recem criado
ola, cliquem em cima dele e escolha o mundo. Do lado direito deve aparecer
apenas a funcdo “teste” com um campo a pedir a nossa variavel S$nome, vamos
introduzir o vosso nome, exemplo jodo, e carregar em call.

Se tudo correr bem ao fundo dessa pagina terdo algumas tabs e na Results
aparecerd o devolvido pelo return da funcdo, neste caso o0ld jodo, provavelmente
irdo aparecer uns caracteres esquisitos, Jja& que o valor é devolvido com um
padrdo de caracteres diferente, para alterar isso voltamos ao nosso mundo.php e
colocamos em vez de return “old ”.S$nome colocamos:

return "Ol& ".utf8 decode ($Snome);

e testem o call de novo no browser. Agora deve devolver em Results a string “0la
jodo” correctamente.

Neste momento o servigo estd a funcionar correctamente, sé temos que fazer com
que o flex o teste com sucesso também. O flex por si n&o sabe o que é o amfphp e
muito menos onde o ir buscar, por isso deveremos incluir um services-config.xml
na altura da compilacdo. Podem fazer o download do meu site do services-
config.xml j& configurado para a nossa aplicacéo.

Download em: http://www.msdevstudio.com/mywork/services-config.rar

devem extrair o ficheiro services-config.xml para a raiz do projecto (ou na

pasta src conforme definido antes no main source folder) (c:\wamp\www\olaMundo)
e caso o caminho da aplicag¢do no vosso servidor ndo seja o
http://localhost/olaMundo devem editar este services-config.xml com o bloco de

notas e ao fundo onde tem:

uri="http: localhost/olaMundo/amfphp/gateway.php"

devem alterar para o caminho correcto do vosso servidor e guardar.

Depois voltamos ao flex, ao nosso projcto olaMundo e vamos ao menu:
Project->Properties->Flex Compiler e no campo onde tem -locale en US vamos

escrever:

-locale en US -services "services-config.xml"

e carregar em Apply, aguardem a actualizacdo e cliquem em Ok.

Se aparecer um erro, cliquem em cima do projecto OlaMundo com o botdo direito e
depois Refresh e o erro deve desaparecer.

Se tudo correu bem, estamos prontos para o nosso primeiro teste com objectos
remotos, neste caso o amfPhp, para isso no cdédigo do nosso olaMundo.mxml antes
da tag </mx:Application...> colocamos 0S NoOsSsSO Servico:
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<mx:RemoteObject id="nossoObjecto" destination="amfphp" source="ola.mundo">
<mx:method name="teste" result="{lidaTeste (event) }">
<mx:arguments>
<nome>
{"Anténio"}
</nome>
</mx:arguments>
</mx :method>
</mx:RemoteObject>

e criar a seguinte funcdo no nosso mainScript.as no final:

private function lidaTeste (evento:ResultEvent) :void ({
Alert.show ("Adivinha? o php respondeu a nossa chamada e
devolveu:\n"+ (evento.result as String));

}

e colocar junto dos imports:
import mx.rpc.events.ResultEvent;

O nosso Objecto estd pronto, e a funcdo para lidar com os resultados também...
vamos adicionar um botdo ao lado no nosso “Define user” no olaMundo.mxml,
bastando no cédigo a seguir a esse botdo colocar:

<mx:Button x="110" y="244" label="Chama RO" click="nossoObjecto.teste.send()"/>

Guardem todos os vossos ficheiros vamos a explicacdes antes de lancar a
aplicacéo.

Criamos o nosso RemoteObject com o id="nossoObjecto” que serd utilizado para

J
chamar qualquer funcdo deste objectos, com o destination="amfphp” que é indicado
no services-config.xml e com o source="ola.mundo” que s&d80 O NOosso servigo:

pasta.ficheiro dentro da pasta services do amfphp.

Depois temos o <mx:method ..> onde o name é exactamente o nome da nossa funcgédo
php, para cada fungdo devemos ter um método. O result é a funcdo que vai lidar
com os resultados devolvidos pelo php.

A tag <mx:arguments> indica o inicio dos argumentos a passar, Nno nosso caso a
funcdo do php teste apenas recebe a variavel $nome (<nome>) e no nosso cddigo
colocamos o conteudo da variével, neste caso “Antdénio”.

Se tivermos mais varidveis a receber, devemos coloca-las sempre pela respectiva
ordem... um exemplo, se a funcdo php receber 3 varidveis, por exemplo:

function teste($nome, $idade, $local); devemos colocar no nosso remote object o
seguinte:

<mx:arguments>
<nome>
{"Antbénio"}
</nome>
<idade>
(21"}
</idade>
<local>
{"Lisboa"}
</local>
</mx:arguments>



Logo depois temos a nossa funcdo para “tratar” os dados recebido no
remoteObject, a qual recebe um evento de resultado (evento:ResultEvent) no qual
sdo incluidos os dados enviados pelo amfphp tratados como evento.result, ao
fazer o Alert.show(); tratei-os como string (as String)

Basta entdo correrem a vossa aplicacdo depois de a ter salvo e carregarem no
bot&do “Chama RO” e se tudo correu bem, tém a vossa aplicacdo a comunicar com o
php via amfphp remote object.

Bem, por agora é tudo, na prdéxima parte do tutorial iremos utilizar este exemplo
para fazer o login numa base de dados mysgl e buscar dados para a nossa dataGrid
presente no exemplo.



